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Copyright Notice 
 

 

 

Copyright © 1999-2010 ApSIC S.L.  

Tutti i diritti riservati.   

 

Il software descritto nella presente documentazione contiene informazioni di proprietà di ApSIC S.L. ed è 

protetto dalle leggi sul copyright.  

 

A causa del continuo sviluppo del prodotto, le informazioni presenti possono essere modificate senza preavviso. 

Le informazioni e i diritti di proprietà intellettuale contenuti nel presente documento sono di natura riservata, 

riguardano ApSIC S.L. e l'utente, e rimangono di proprietà esclusiva di ApSIC S.L. Si prega di comunicare per 

iscritto eventuali problemi rilevati nella presente documentazione. ApSIC S.L. non garantisce che il presente 

documento sia di privo di errori. 

Nessuna parte del presente documento può essere riprodotta, inserita in sistemi di riproduzione o trasmessa in 

qualsiasi forma e con qualsiasi mezzo senza l‟autorizzazione scritta di ApSIC S.L.  

 

Il presente documento contiene marchi o marchi registrati di proprietà esclusiva dei legittimi proprietari e 

ApSIC riconosce tale proprietà. 

 

 

 

 

 

ApSIC, S.L.  
Caballero, 76 4-3  

08029 Barcellona  

Spagna  

+34 93 405 11 00  

http://www.apsic.com 
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Generalità 
 

ApSIC Xbench è un programma che permette di organizzare e fare ricerche sulla terminologia 

bilingue di riferimento e offre varie funzionalità di Quality Assurance (QA) per migliorare la 

qualità delle traduzioni.  

 

 

Funzionalità di ricerca 
 

Con ApSIC Xbench è possibile effettuare efficacemente ricerche sui seguenti tipi di 

file bilingui:  

  

 file .txt 

 file TMX  

 file tbx  

 memorie di traduzione esportate da Trados 

 glossari di Multiterm 5 

 formati xml di Trados Multiterm 

 file .ttx di TRADOS TagEditor  

 file di word .rtf e .doc “uncleaned” tradotti con TRADOS  

 file .itd di SDLX. Avvertenza: Questa opzione richiede SDLX installato nel 

computer.  

 memorie SDLX  

 dizionari esportati da IBM TranslationManager  

 cartelle installate ed esportate da IMB TranslationManager  

 coppie di file STAR Transit  

 memorie di Wordfast  

 glossari di Wordfast  

 file DejaVu X/Idiom  

 file .rtf di Logoport  

 glossari in formato Microsoft .csv  

 file XLIFF di Oracle  

 glossari Mac Glossari Remote Xbench Server  

 

La terminologia di riferimento può essere organizzata in vari livelli di priorità per 

indicare chiaramente ai traduttori le impostazioni specifiche di ogni progetto di 

traduzione. 
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ApSIC Xbench è sempre attivo in background e può essere richiamato per ricercare un 

testo precedentemente selezionato utilizzando una combinazione di tasti 

personalizzabile (per impostazione predefinita è Ctrl+Alt+Ins). 

Questo metodo permette ricerche terminologiche immediate da qualsiasi applicazione 

di Windows utilizzando una semplice combinazione di tasti.   

 

ApSIC Xbench dispone di un motore di ricerca molto potente; non solo è possibile 

effettuare ricerche sul testo source e sul testo target, ma anche ricerche con condizioni 

o ricerche per esclusione tramite la funzione PowerSearch (Ctrl+P).  

È inoltre possibile svolgere ricerche complesse utilizzando la sintassi delle espressioni 

regolari o dei caratteri jolly di Microsoft Word.   

 

Avvertenza: Dopo l‟avvio, ApSIC Xbench opera in background fino a quando non 

viene chiuso con il comando Shutdown Xbench facendo clic con il tasto destro del 

mouse sull'icona di Xbench nella barra delle attività di Windows o utilizzando il 

comando Shutdown Xbench nel menu a tendina Project.   

 

 

 

Funzionalità di QA 
 

 

Nel progetto Xbench, definendo i file della traduzione su cui si lavora come traduzione in 
corso (ongoing translation) è possibile effettuare i seguenti controlli di QA:  

 

 Trovare segmenti non tradotti.    

 Trovare segmenti con lo stesso testo di partenza ma con testo di destinazione differente.   

 Trovare segmenti con lo stesso testo di destinazione ma con testo di partenza differente.  

 Trovare segmenti in cui il testo di destinazione corrisponde al testo di partenza (testo 

potenzialmente non tradotto).  

 Trovare tag non corrispondenti. 

 Trovare numeri non corrispondenti.  

 Trovare mancata corrispondenza di termini rispetto a una lista di termini chiave.  

 Eseguire liste di controllo definite dall‟utente. 

 

Le liste di controllo sono ricerche definite dall‟utente che possono essere eseguite in modalità batch 

sulla traduzione in corso.  Ad esempio, con le liste di controllo è possibile effettuare ricerche di parole 

"da evitare" o ricerche di errori più comuni dei traduttori.  
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Installazione e rimozione  
di ApSIC Xbench 

 

Installazione di ApSIC Xbench 
 

 

Per installare ApSIC Xbench procedere come segue:  

 

Avviare il programma eseguibile d‟installazione  (ad esempio 

Setup.Xbench.2.8.exe). Viene visualizzata la schermata iniziale del 

programma d‟installazione. 

 

 

 

 

  Fare clic su Next. Viene visualizzata la finestra della licenza.   

Si prega di leggere attentamente le informazioni contenute per assicurarsi di 

accettare i termini della licenza.  

 

Per accettare i termini della licenza, fare clic su "I Agree".   

Per non accettare i termini della licenza fare clic su “Cancel”.  
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Cambiare la cartella di destinazione se necessario e fare clic su Install per continuare.   

I file vengono copiati nella cartella selezionata e viene visualizzata la finestra 

seguente.  
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Fare clic su Finish per chiudere la finestra ed iniziare ad utilizzare ApSIC Xbench.   

 

Nel percorso Avvio->Programmi->ApSIC Tools->Xbench viene installato un 

collegamento con il file eseguibile di ApSIC Xbench e con la documentazione.    

 

 

 

Rimozione di ApSIC 
Xbench 

 
Per rimuovere ApSIC Xbench procedere come segue:  

 

1 Selezionare Avvio->Impostazioni->Pannello di controllo sulla barra delle 

attività di Windows. Andare nel Pannello di Controllo e aprire l‟icona 

Aggiungi/Elimina Programmi. 
 

2  Cercare ApSIC Xbench nell‟elenco e fare clic sul pulsante Cambia o Elimina. 

 

3  Scegliere Si quando viene visualizzato di messaggio di conferma.  
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Avvio e chiusura di  
ApSIC Xbench 

 

ApSIC Xbench è un‟applicazione che una volta avviata deve essere 

appositamente chiusa se non è più utilizzata.   Di solito occorre caricare il 

progetto di riferimento per effettuare ricerche sulla terminologia mentre si 

effettua la traduzione e lasciare l‟applicazione in background fino a quando la 

traduzione non è terminata. La chiusura della finestra di ApSIC Xbench non 

ne interrompe l‟esecuzione e l‟applicazione rimane in attesa della prossima 

query con la combinazione di tasti Ctrl+Alt+Ins.  

 

 

Avvio di ApSIC Xbench 
 

Per avviare ApSIC Xbench procedere in uno dei modi seguenti:  

 

 Selezionare Avvio->Programmi->ApSIC Tools->Xbench sulla barra 

delle attività di Windows. 

 Fare doppio clic sull‟icona di un progetto di ApSIC Xbench 

precedentemente creato (con estensione .xbp).  

 

 

Chiusura di ApSIC Xbench 
 

Per chiudere l‟applicazione ApSIC Xbench, sono disponibili le seguenti 

opzioni:  

 

 Fare clic con il tasto destro del mouse sull‟icona ApSIC Xbench (un 

diamante rosa) posizionata nella barra delle applicazioni attive (nella 

parte inferiore destra dello schermo) e fare clic su Shutdown 

Xbench.    
 

 Nel menu Project, fare clic su Shutdown Xbench 
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Ricerca di terminologia 
 

 

In questa sezione verranno fornite informazioni sulle funzioni di ricerca di ApSIC 

Xbench.  Per comprendere il funzionamento di ApSIC Xbench sono utili i seguenti 

concetti:  

 

Progetto: In ApSIC Xbench un progetto è una definizione di vari file con le loro 

priorità e relazioni.  La prima cosa da fare in ApSIC Xbench è definire un progetto  

con la terminologia da analizzare e il modo in cui effettuare la ricerca.    

 

Traduzione in corso (“Ongoing translation”): Con ApSIC Xbench è possibile 

definire un file o un gruppo di file come "traduzione in corso" (Ongoing Translation) e 

quindi visualizzare le stringhe di tale file nei risultati della ricerca.  Inoltre le 

funzionalità di QA possono essere eseguite su file definiti come Ongoing Translation.   

 

PowerSearch: È una particolare modalità  di ricerca in cui è possibile impostare 

condizioni con operatori di tipo AND/OR e impostare ricerche ad esclusione sulle 

stringhe, realizzando quindi ricerche complesse. È una funzionalità molto utile per le 

operazioni di QA.   

 

Espressioni regolari: Un‟espressione regolare è una stringa di ricerca contenente 

caratteri speciali con significati particolari che forniscono un modo rapido e flessibile 

per identificare sequenze di caratteri o parole. La sintassi delle espressioni regolari si 

basa su standard condivisi. Questa è una delle modalità di ricerca e di QA di ApSIC 

Xbench.    

 

Caratteri jolly di Microsoft Word: Con ApSIC Xbench è possibile anche eseguire 

ricerche utilizzando i caratteri jolly di Microsoft Word, che adottano una sintassi 

simile a quella delle espressioni regolari, ma leggermente più semplificata.    
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Definire progetti di ricerca 
 

Il primo passo per utilizzare le potenti funzionalità di ricerca di ApSIC Xbench è 

quello di definire il materiale di riferimento del progetto.  A tale fine, occorre 

aggiungere al progetto i file e le cartelle necessarie con il comando Project-

>Properties oppure premendo il tasto F2.   

Viene visualizzata la seguente finestra di dialogo Project Properties.  

 

 
 

Fare clic sul pulsante Add per aggiungere i file al progetto.   

 

Selezionare il tipo di file da aggiungere al progetto di ApSIC Xbench:  
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 ApSIC Xbench può gestire i seguenti tipi di file:  
 

 File testo delimitato da tabulazioni  (.txt). Un file in cui ogni riga è composta da campi 

delimitati dal carattere di tabulazione.  Si presuppone che il primo ed il secondo campo di 

un record siano rispettivamente il testo di partenza ed il testo di destinazione  e che gli 

ulteriori campi (in numero qualsiasi) siano descrittivi.   

 Memorie TMX.   Un file TMX (Translation Memory eXchange). La maggior parte dei 

software di traduzione è in grado di generare memorie in formato TMX con differenti 

livelli di conformità.   

 File TBX.  Un singolo file TBX.  

 Memoria esportata da Trados.  Una memoria esportata da Trados in formato .txt.  

 Glossario esportato da Trados Multiterm 5. Un glossario di Multiterm esportato in un file .txt 

in cui ogni record è delimitato dal una riga contenente due asterischi (**).  

 Glossario XML di Trados Multiterm. Un glossario di Multiterm esportato in formato XML.   

 File o struttura ad albero di Trados TagEditor.  Un singolo file .ttx di Trados o una cartella 

contenente vari file .ttx di Trados.  Questo formato può essere definito come traduzione in 
corso, per distinguere chiaramente la traduzione vecchia da quella nuova e per visualizzare 

anche i segmenti non tradotti al fine di fare scelte più accurate per la terminologia nuova.  

 File o struttura ad albero di Trados Word.  Un singolo file .doc o .rtf creato con Trados o una 

cartella contenente vari file .doc o .rtf creati con Trados in cui sono presenti i segmenti 

bilingui.   Questo formato viene anche definito “Trados uncleaned format”.   Questo 

formato può essere definito come traduzione in corso, per distinguere chiaramente la 

traduzione vecchia da quella nuova e per visualizzare anche i segmenti non tradotti al fine 

di fare scelte più accurate per la terminologia nuova.  

 File o struttura ad albero di SLDX.  Un singolo file .itd di SDLX o una cartella e varie 

sottocartelle selezionate contenenti vari file .itd di SDLX. Questo formato può essere 

definito come traduzione in corso, per distinguere chiaramente la traduzione vecchia da 

quella nuova e per visualizzare anche i segmenti non tradotti al fine di fare scelte più 

accurate per la terminologia nuova.  Avvertenza: questa opzione richiede SDLX installato 

nel computer.  

 Memorie SDLX. Un singolo file .mdb di SDLX contenente una memoria di traduzione. 

 Struttura ad albero di STAR Transit.  La cartella che contiene le coppie di file di Transit.  

Questo formato può essere definito come traduzione in corso, per distinguere chiaramente 

la traduzione vecchia da quella nuova e per visualizzare anche i segmenti non tradotti al 

fine di fare scelte più accurate per la terminologia nuova.  

 Dizionario di IBM TM. Un dizionario di IBM TranslationManager in formato SGML.  Questo 

file ha l'estensione .sgm. 

 Cartella di IBM TM. Una cartella di IBM TRanslationManager installata nel sistema.  Questo 

formato può essere definito come traduzione in corso, per distinguere chiaramente la 

traduzione vecchia da quella nuova e per visualizzare anche i segmenti non tradotti al fine 

di fare scelte più accurate per la terminologia nuova.  

 Cartella esportata da IBM TM. Una cartella di IBM TranslationManager esportata in formato 

.FXP.   
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 Memoria di Wordfast. Una memoria di Wordfast, con estensione .txt.   

 Glossario di Wordfast. Un glossario di Wordfast, con estensione .txt.   

 File DejaVu X/Idiom. Un database di DejaVu o Idiom di file di progetti di traduzione, con 

estensioni .dvprj o wsprj.   

 Memorie di DejaVu X/Idiom.  Una memoria di traduzione di DejaVu o Idiom, con estensioni 

.dvmdb o wstm.  

 File RTF di Logoport.  Un file di Logoport in formato .rtf  

 Glossario Microsoft. Un glossario software fatto da Microsoft, pubblicato da Microsoftt 

tramite MSDN e contenente tutte le stringhe delle applicazioni software di Microsoft. 

 Glossario Mac OS X. Un glossario in formato XML di Apple sul software, disponibile 

gratuitamente su Internet. 

 File XLIFF di Oracle. Un singolo file XLIFF di Oracle.  

 Remote Xbench Server. Un riferimento ad un server remoto ApSIC Xbench.   

 

Dopo aver selezionato il file, a seconda del tipo, viene visualizzata la scheda Folder List o File 

List in cui si è possibile  aggiungere i vari tipi selezionati. Fare clic sul pulsante Add per 

aggiungere un file al progetto. 

 

 A partire da questa fase, la sequenza delle schermate visualizzate è diversa a seconda del tipo 

di file selezionato.  Per procedere correttamente, seguire le istruzioni seguenti:  

 

Se si seleziona… Procedere come segue:  
 

file .txt, memorie TMX, memorie 

esportate da Trados, file di Trados Tag 

Editor, file Word di Trados, file 

SDLX, memorie SDLX, dizionario di 

IBM TM, cartella esportata da IBM 

TM, memoria di Wordfast, glossario di 

Wordfast, glossario Microsoft, File 

XLIFF di Oracle, glossari Mac OS X, 

file DejaVu X/Idiom, memoria di 

DejaVu X/Idiom, file RTF di 

Logoport.  

 

 

1 Viene visualizzata la scheda File List,   

automaticamente si apre la finestra di 

dialogo Add Glossary.  Selezionare 

tutti i file del tipo scelto in questa 

finestra.  Se si vogliono selezionare 

altri file da una cartella diversa, quando 

si è di nuovo nella scheda File List, 

fare clic  sul pulsante Add per aprire la 

finestra Add Glossary.   

 

2 Fare clic su Next nella scheda File List 

per arrivare alla scheda Properties. 

 

3 Assegnare le proprietà necessarie e fare 

clic su OK per terminare.  
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struttura ad albero di Trados 

TagEditor, struttura ad albero di 

Trados Word, struttura ad albero 

di STAR Transit o struttura ad 

albero di SDLX  

1 Dopo che viene visualizzata la scheda Folder 

List, si apre automaticamente la finestra di 

dialogo Select Directory...  Scorrere le cartelle 

fino a selezionare quella contenente i file che si 

desidera caricare nel progetto di ApSIC 

Xbench.  

 

2 Fare clic su Next nella scheda File List per 

arrivare alla scheda Properties. 

   

3 Assegnare le proprietà necessarie alla struttura 

ad albero e fare clic su Next per arrivare alla 

scheda Directory Settings. 

  

4 Nella scheda Directory Settings è possibile 

attivare la casella di controllo Recurse 

Directories per effettuare la ricerca di file .itd 

anche nelle sub cartelle.     

 

glossario esportato da Trados 

Multiterm 5, glossario XML di 

Trados Multiterm, o TBX  

 

1 Viene visualizzata la scheda File List, 

automaticamente si apre la finestra di dialogo 

Add Glossary.  Selezionare tutti i file del tipo 

scelto in questa finestra.  Se si vogliono 

selezionare altri file da una cartella diversa, 

quando si è di nuovo nella scheda File List, 

fare clic sul pulsante Add per aprire di nuovo 

la finestra Add Glossary. 

 

2 Fare clic su Next nella scheda File List per 

arrivare alla scheda Properties. 

 

3 Assegnare le proprietà necessarie al file e fare 

clic su Next per arrivare alla scheda Multiterm 

XML.  

 

4 Nella scheda Multiterm XML, selezionare la 

lingua di origine e quella di destinazione dalla 

lista delle lingue disponibili e fare clic su OK 

per terminare. 

 

cartella di IBM TM 

 

1 Dopo che viene visualizzata la scheda Folder 

List, e si apre automaticamente la finestra di 

dialogo Open IBM TM Folder. Se necessario, 

cambiare l‟unità contenente la cartella IBM TM 

e selezionare la/le cartella/e nell‟elenco delle 

cartelle  visualizzato.  

 

2 Fare clic su Next nella scheda File List per 

arrivare alla scheda Properties. 

 

3 Assegnare le proprietà necessarie e fare clic su 

OK per terminare. 
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Remote Xbench Server. 

 

1 Assegnare le proprietà necessarie e fare clic su 

Next per arrivare alla scheda Remote Xbench 

Server.  
2 Assegnare un nome alla connessione e 

specificare l‟URL del Server Xbench.  
 

 

 

 Dopo essere tornati nella finestra Project Properties, è possibile aggiungere altri file o 

cartelle in base alle istruzioni precedenti.   

 

Una volta terminato, fare clic su OK nella finestra Project Properties per tornare alla finestra 

principale di ApSIC Xbench.  ApSIC Xbench caricherà i glossari nell‟ambiente di lavoro.    

 

A questo punto  nel menu Project, fare clic su Save as.. per salvare la definizione di glossario 

appena creata in una cartella a piacere insieme ad altri progetti ApSIC Xbench.  Si consiglia di 

salvare i file di progetto con nomi adeguati in caso di successivo utilizzo.  

 

 

Avvertenza: Quando si riavvia ApSIC Xbench, verrà automaticamente ricaricato l‟ultimo 

progetto aperto, a meno che non viene disattivata questa opzione in Tools->Settings-

>Miscellaneous Settings.   
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Ricerca di termini 
 

 

ApSIC Xbench dispone di un motore di ricerca molto potente.  È possibile ad esempio, 

effettuare ricerche su termini nella lingua  di partenza, nella lingua di destinazione, e 

su entrambe. ApSIC Xbench consente anche di effettuare ricerche utilizzando le 

espressioni regolari o i caratteri jolly di Microsoft Word, e di utilizzarli insieme in 

modalità PowerSearch.  

 

 
 

Probabilmente la maggior parte delle ricerche vengono eseguite sul termine nella 

lingua di origine. Tuttavia, la necessità di effettuare ricerche su un termine non si 

presenta quando si è nell‟interfaccia di ApSIC Xbench, bensì mentre si effettua la 

traduzione in Word, o in altri strumenti di traduzione assistita, come Trados 

Translator's Workbench, SDLX, IBM TranslationManager, Déjà Vu, oppure nel 

programma di posta elettronica, come Microsoft Outlook o Firebird.   

 

Per questo motivo, ApSIC Xbench è accessibile da qualsiasi applicazione con 

un’unica combinazione di tasti (Ctrl+Alt+Ins).   

 

Nei 5 punti successivi si descrivono le modalità con cui procedere in ApSIC Xbench.  

Il punto di partenza in questo caso è un documento attivo di Microsoft Word su cui si 

sta lavorando e un progetto di ApSIC Xbench caricato in background.   

 

1 In Microsoft Word, selezionare (interamente o parzialmente) il termine da 

ricercare.  
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2 In Microsoft Word, premere Ctrl+Alt+Ins per lanciare ApSIC Xbench. Viene 

avviata automaticamente la ricerca del termine selezionato. Questa combinazione 

di tasti è la più importante quando si lavora con ApSIC Xbench.  

 

3 ApSIC Xbench mostra il risultato della query nella maniera riprodotta dalla figura 

precedente.  È possibile definire fino a tre aree di priorità: verde, (priorità alta), 

rosso bordeaux (priorità media), e blu (priorità bassa).  La colonna contrassegnata 

con il simbolo # indica il numero delle occorrenze nel file esaminato del termine 

indicato nella finestra. 

 

 Il punto verde (    )  di fianco  al termine nella lingua di destinazione indica che la 

voce ha una corrispondenza esatta con la stringa ricercata (anche per i caratteri 

maiuscoli/minuscoli).   

Il punto giallo (    )   visualizzato di fianco al termine nella lingua di destinazione 

indica che la voce ha una corrispondenza esatta tranne che per i caratteri 

maiuscoli/minuscoli. Ad esempio, nel caso precedente la stringa ricercata è stata 

“clipboard”, (con la c minuscola) anzichè “Clipboard” ed il punto visualizzato è 

giallo anziché verde perché la stringa della query è diversa da quella trovata nel 

file. 

 

Quando si traduce la documentazione, questa indicazione è molto utile perché è 

possibile copiare e incollare il termine nella lingua di destinazione, consentendo 

una maggiore produttività e precisione. Qui di seguito è possibile vedere come 

realizzarle.  

 

4 Per copiare negli appunti il termine nella lingua di destinazione  basta premere il 

tasto INVIO chiudendo così la finestra di ApSIC Xbench. ApSIC Xbench viene 

nascosto e si ritorna all'applicazione di partenza (in questo caso Microsoft Word). 

 

Importante: Se non si vuole copiare nulla negli appunti, premere il tasto Esc o 

Alt+F4 per nascondere ApSIC Xbench e ritornare a Microsoft Word.   

 

5 Se si sceglie di chiudere la finestra di ApSIC Xbench con il tasto INVIO salvando 

quindi negli appunti il termine nella lingua di destinazione, è possibile premere 

Shift+Ins per copiarlo nel documento.   

 

È facile capire che, soprattutto per nel campo delle traduzioni di  messaggi software, è 

più veloce cercare e incollare piuttosto che scrivere a mano i messaggi;  è quindi 

possibile aumentare contemporaneamente la produttività e la coerenza della 

traduzione.     

 

Suggerimento: Ripetere la procedura precedente per acquisire dimestichezza fino a 

quando non diventa intuitiva. Ricercare parole che hanno corrispondenza esatta in 

modo da impadronirsi del procedimento per incollare.  
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C A P I T O L O  5  
 

 

 

Espressioni regolari e  
caratteri jolly di Microsoft Word  

 

 
Con ApSIC Xbench è possibile realizzare potenti ricerche utilizzando le espressioni 

regolari o i caratteri jolly di Microsoft Word.   Per attivare le modalità di ricerca 

procedere come segue:  

 

1. Scegliere View->Search Options per visualizzare il riquadro Search Options.   

 

2. Aprire il menu a discesa Search Mode e scegliere Regular Expression o MS 

Word Wildcards.     

 

3. Verrà visualizzata un‟icona di fianco ai campi Source Term e Target Term 

ad indicare la modalità selezionata.   

 

Sintassi delle espressioni regolari 
 

Carattere o 
Espressione 

Significato Esempi 

. Un carattere qualsiasi 
Jo.n corrisponde a John e Joan, ma non a 

Johan 

* 
 0 o più istanze del carattere 

precedente 

Joh*n corrisponde a Jon, John, e Johhn, ma 

non a Johan.  

 

Avvertenza: Nelle espressioni regolari, 

l'asterisco non segue le stesse regole dei 

caratteri jolly di Microsoft Word.  Per indicare 

un numero qualsiasi di carattere occorre 

utilizzare la sequenza punto-asterisco (.*).  Per 

esempio, Joh*n corrisponde a John, Johhn, e 

Johan (ma non a Jon).  

? 0 o 1 istanza del carattere precedente 
Joh?n corrisponde a Jon e John, ma non a 

Johan 

+ 
1 o più ripetizioni del carattere 

precedente. 

Joh+n corrisponde a John, e Johhn, ma non a 

Jon o Johan 

{m} 
Esattamente m ripetizioni del 

carattere precedente   

Joh{2}n corrisponde a Johhn, ma non a Jon 

John o Johhhn.  
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Carattere o 
Espressione 

Significato Esempi 

{m,} 
m o più ripetizioni del carattere 

precedente 

{2,}n corrisponde a Johhn, o Johhhn ma non 

corrisponde a Jon o John.  

{,n} 
Da 1 a n ripetizioni del carattere 

precedente 

Joh{,2}n corrisponde a John e Johhn, ma non 

a Jon, o Johhhn.  

{m,n} 
Da m a n ripetizioni del carattere 

precedente 

Joh{1,2}n corrisponde a John e Johhn, ma non 

a Jon, o Johhhn.  

< Inizio della parola <Phon corrisponde a Phone, ma non a iPhone 

> Fine della parola 

Hones> corrisponde a Phones, ma non a 

Phone.  

 

Avvertenza: Per ricercare una parola intera, è 

possibile specificare <Phone> per ottenere 

Phone, ma non Phones o iPhone; oppure è 

possibile specificare <Phones*> per ottenere 

sia Phone che Phones, ma non iPhone o 

iPhones.  

^ 
Inizio di riga (deve trovarsi all‟inizio 

dell‟espressione)  

^Phone corrisponde a tutte le parole che 

iniziano con Phone 

$ 
Fine di riga (deve trovarsi alla fine 

dell‟espressione)  

received$ corrisponde a tutte le parole che 

finiscono con received.  

\ 

Carattere Esc. Il carattere successivo 

è riconosciuto come carattere 

normale. 

phone\. corrisponde a tutte le unità che 

presentano un periodo dopo phone.(In questo 

caso, il punto non significa “qualsiasi” 

carattere perché c‟è il simbolo di Escape).    

% 

 

Il carattere o l‟espressione precedente 

non fanno distinzione tra maiuscole e 

minuscole. Quando Xbench fa 

distinzione tra caratteri maiuscoli e 

minuscoli, questa opzione permette 

di rendere parte della stringa “esente” 

da tale distinzione.   

Quando ApSIC Xbench fa distinzione tra 

maiuscole e minuscole, a% corrisponderà ad a 

e A. Analogamente P(hone)% corrisponde a 

Phone e PHONE perché in quest‟ultimo caso 

la lettera p non è compresa nell‟espressione 

modificata dall‟operatore.  

\xnn 
Il carattere specificato da nn, in cui 

nn è un numero esadecimale.   

\x48\x6f\x77\x64\x79\x3f corrisponde a 

Howdy? 

| 

 
Operatore OR  

^H|I corrisponde a tutte le frasi che iniziano 

con un H o con un I.   

() 
Operatore parentesi per specificare 

priorità.   

(^H)|I corrisponde a tutte le frasi che iniziano 

con H o contengono I.   

[set-expression] 

 

Carattere che appartiene al tipo 

definito in set-expression.  

Un set è definito da caratteri 

individuali (ad esempio, [aeiou]) e/o 

un insieme di caratteri indicati dal 

carattere iniziale e quello finale (ad 

esempio, [a-z]).  

 

File[0-9] corrisponde a File0, File1, File2, ... 

File9, ma non corrisponde a FileX.   

 

File[ABC] corrisponde a FileA, FileB e FileC, 

ma non corrisponde a FileD.  
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Carattere o 
Espressione 

Significato Esempi 

[:special-set] 

Un carattere che appartiene ad uno 

special-set predefinito.  

In ApSIC Xbench sono predefiniti i 

seguenti special set: [:space:], 

[:control:], [:punctuation:], [:punct:],

 [:separator:],  [:sep:], 

 [:symbol:],  [:alpha:], 

 [:num:],  [:xdigit:], 

 [:alphanum:],  [:letter:], 

 [:digit:], 

 [:letterdigit:],  [:number:].  

Lo special set deve essere usato 

all‟interno delle set-expression (ad 

esempio [:digit:]).  

 

File[:digit:] Corrisponde a File0, File1 o File2, 

ma non corrisponde a FileA o FileB.   

File[:alpha:][:digit:] Corrisponde a FileA0, 

FileB1 o FileC2, ma non corrisponde a File1A 

o File2B. 

 

[^set-

expression] 

Qualsiasi carattere che non 

appartiene al tipo definito in set-

expression.   

File[^ABC] corrisponde a FileD or FileE, ma 

non corrisponde a FileA, FileB e FileC. 

(expression)=n 

 Assegna alla variabile n la soluzione 

dell‟espressione nel segmento 

attualmente identificato.  Tale 

soluzione può essere richiamata con 

l‟espressione @n. 

File[0-9])=1 definisce la variabile 1 come 

soluzione di File[0-9].  

@n 
Restituisce la soluzione della 

variabile n.   

@1 nel precedente esempio restituisce File1 se 

la stringa ricercata contiene File1, File2 se 

invece contiene File2, ecc. 

     

 

 

 

 

     

 

 

 

Sintassi dei caratteri jolly di Microsoft Word 
 

 

Carattere o 
Espressione 

Significato Esempi 

. Un carattere qualsiasi 
Jo.n corrisponde a John e Joan, ma non a 

Johan 

*  0 o più caratteri 
Joh*n corrisponde a John e Johhn, Johan ma 

non a Jon.  

? 
0 o 1 carattere 

 

Jo?n corrisponde a Jon, John e Joan, ma non a 

Johan. 

@ 
1 o più ripetizioni del carattere 

precedente. 

Joh@n corrisponde a John, e Johhn, ma non a 

Jon o Johan.  

{m} 
Esattamente m ripetizioni del 

carattere precedente   

Joh{2}n corrisponde a Johhn, ma non a Jon 

John o Johhhn.  
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Carattere o 
Espressione 

Significato Esempi 

{m,} 
m o più ripetizioni del carattere 

precedente 

Joh{2,}n corrisponde a Johhn, o Johhhn ma 

non corrisponde a Jon o John.  

{,n} 
Da 1 a n ripetizioni del carattere 

precedente 

{2,}n corrisponde a Johhn, o Johhhn ma non 

corrisponde a Jon o John.  

{m,n} 
Da m a n ripetizioni del carattere 

precedente 

Joh{1,2}n corrisponde a John e Johhn, ma non 

a Jon, o Johhhn.  

< Inizio della parola <Phon corrisponde a Phone, ma non a iPhone. 

> Fine della parola 

Hones> corrisponde a Phones, ma non a 

Phone.  

 

Avvertenza: Per ricercare una parola intera, è 

possibile specificare <Phone> per ottenere 

Phone, ma non Phones o iPhone; oppure è 

possibile specificare <Phones*> per ottenere 

sia Phone che Phones, ma non iPhone o 

iPhones.  

^ 
Inizio di riga (deve trovarsi 

all‟inizio dell‟espressione)  

^Phone corrisponde a tutte le parole che 

iniziano con Phone 

$ 
Fine di riga (deve trovarsi alla fine 

dell‟espressione)  

received$ corrisponde a tutte le parole che 

finiscono con received.  

\ 

Carattere Esc. Il carattere 

successivo è identificato come 

carattere normale. 

phone\. corrisponde a tutte le unità che 

presentano un periodo dopo phone.(In questo 

caso, il punto non significa “qualsiasi” 

carattere perché c‟è il simbolo di Escape).    

% 

 

Il carattere o l‟espressione 

precedente non fanno distinzione 

tra maiuscole e minuscole. Quando 

Xbench fa distinzione tra caratteri 

maiuscoli e minuscoli, questa 

opzione permette di rendere parte 

della stringa “esente” da tale 

distinzione.   

Quando ApSIC Xbench fa distinzione tra 

maiuscole e minuscole, a% corrisponderà ad a 

e A. Analogamente P(hone)% corrisponde a 

Phone e PHONE perché in quest‟ultimo caso 

la lettera P non è compresa nell‟espressione 

modificata dall‟operatore.  

\xnn 
Il carattere specificato da nn, in cui 

nn è un numero esadecimale.   

\x48\x6f\x77\x64\x79\x3f corrisponde a 

Howdy? 

| 

 
Operatore OR  

^H|I corrisponde a tutte le frasi che iniziano 

con un H o con un I.   

() 
Operatore parentesi per specificare 

priorità.   

(^H)|I corrisponde a tutte le frasi che iniziano 

con H o contengono I.   

[set-expression] 

 

Carattere che appartiene al tipo 

definito in set-expression.  

Un set è definito da caratteri 

individuali (ad esempio, [aeiou]) 

e/o un insieme di caratteri indicati 

dal carattere iniziale e quello finale 

(ad esempio, [a-z]).  

 

File[0-9] corrisponde a File0, File1, File2, ... 

File9, ma non corrisponde a FileX.   

 

File[ABC] corrisponde a FileA, FileB e FileC, 

ma non corrisponde a FileD.  

 

[!set-expression] 

Qualsiasi carattere che non 

appartiene al tipo definito in set-

expression.   

File[!ABC] corrisponde a FileD or FileE, ma 

corrisponde a FileA, FileB e FileC. 
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Carattere o 
Espressione 

Significato Esempi 

[:special-set] 

Un carattere che appartiene ad uno 

special-set predefinito.  

In ApSIC Xbench sono predefiniti i 

seguenti special set: [:space:], 

[:control:], [:punctuation:], 

[:punct:], [:separator:], 

 [:sep:],  [:symbol:], 

 [:alpha:],  [:num:], 

 [:xdigit:], 

 [:alphanum:],  [:letter:], 

 [:digit:], 

 [:letterdigit:], 

 [:number:].  

Lo special set deve essere usato 

all‟interno delle set-expression (ad 

esempio [:digit:]).  

 

File[:digit:] Corrisponde a File0, File1 o File2, 

ma non corrisponde a FileA o FileB.   

File[:alpha:][:digit:] Corrisponde a FileA0, 

FileB1 o FileC2, ma non corrisponde a File1A 

o File2B. 

 

(expression)=n 

 Assegna alla variabile n la 

soluzione dell‟espressione nel 

segmento attualmente identificato.  

Tale soluzione può essere 

richiamata con l‟espressione \n. 

File[0-9])=1 definisce la variabile 1 come 

soluzione di File[0-9].  

\n 
Restituisce la soluzione della 

variabile n.   

\1 nel precedente esempio restituisce File1 se 

la stringa ricercata contiene File1, File2 se 

invece contiene File2, ecc. 
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C A P I T O L O  6  
 

 

Funzionalità avanzate 
 
ApSIC Xbench è dotato di funzionalità avanzate molto utili in caso di specifiche 

esigenze descritte nelle sezioni successive.  

 

 

Funzione PowerSearch 
 

 
È possibile utilizzare la combinazione di tasti Ctrl+P (PowerSearch) per effettuare 

ricerche con criteri più complessi.  Tramite la funzione PowerSearch è possibile 

ricercare elementi che:  

 Contengono due o più stringhe, ma non necessariamente consecutive.   

 Non contengono una determinata stringa.   

 Contengono una stringa oppure un‟altra 

 Una combinazione qualsiasi delle precedenti ricerche 

 

Esempi:  

 
 
L’espressione ...  

 

...Permette le ricerche seguenti: 
   

stringa1 stringa2  
Trova tutte gli elementi che contengono "stringa1" 

e "stringa2"  

stringa or stringa2 

 

Trova tutte gli elementi che contengono "stringa1" 

o "stringa2"  

stringa1 -stringa2 

 

Trova tutte gli elementi che contengono "stringa1" 

ma non contengono "stringa2"  

stringa1 -"stringa2 con spazi 

vuoti" 

 

Trova tutte gli elementi che contengono "stringa1" 

ma non contengono "stringa2 con spazi vuoti" 

       

 
In espressioni ancora più complesse con combinazioni di stringhe, operatori booleani e 

relazioni, è possibile utilizzare le parentesi per indicare la priorità.  

 

In modalità PowerSearch, occorre utilizzare le virgolette come delimitatori se 

l‟espressione contiene spazi vuoti o parentesi.  Se l‟espressione stessa da ricercare 

contiene al suo interno le virgolette, occorre isolarle utilizzando una sequenza di 

doppie virgolette.   

 

Avvertenza: Se una delle parole da ricercare in modalità PowerSearch è la parola “or”, 

occorre scrivere la parola “or” tra virgolette per evitare che venga riconosciuta come 

operatore.  
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PowerSearch può essere utilizzato in una qualsiasi delle seguenti modalità: Semplice, 

Espressioni regolari e caratteri jolly di Microsoft Word. 

 

 

Ingrandimento   

 

ApSIC Xbench presenta 3 tipi di ingrandimento:  

 

 Ingrandimento Priority Level   

 Ingrandimento Glossary   

 Ingrandimento File   

 

Come precedentemente accennato, con ApSIC Xbench è possibiler visualizzare 

l'immagine del termine più rilevante per ogni livello di priorità in un'unica modalità di 

visualizzazione. In questa maniera è possibile analizzare le possibile presenza di 

incongruenze o anche di significati diversi e prendere decisioni più accurate sulla 

scelta dei termini.  

 

È tuttavia possibile che occorra visualizzare ulteriori o (o tutte) le occorrenze di un 

livello specifico per effettuare un‟analisi più approfondita di un termine.   

 

A tale fine, fare doppio clic sulla parte centrale della finestra del livello di priorità che 

si vuole ingrandire per ottenere l‟elenco completo di tutte le occorrenze del termine 

ricercato.  Lo sfondo diverrà di colore verde segnalando che si è in modalità 

ingrandita.   

 

Per uscire dalla modalità ingrandita, fare doppio clic di nuovo sulla parte centrale della 

finestra.  

 

 

Ricerca inversa 
 
In ApSIC Xbench è presente anche un metodo basato sulla tastiera per effettuare la 

ricerca in base alla colonna target piuttosto che alla colonna source.  La combinazione 

di tasti predefinita per questa funzionalità è Ctrl+Alt+Backspace  

 

Ciò equivale a lasciare il campo Source Term vuoto e riempire il campo Target 

Term.  

 

Questo ricerca può essere opportuna, ad esempio, se si vuole utilizzare un nuovo 

termine nella propria lingua e si vuole essere certi che tale termine non è già stato 

utilizzato per non creare potenziali conflitti futuri nella terminologia chiave del 

progetto. 

 

 

Ricerca solo  
nelle traduzioni in corso (ongoing translations) 

 
Nel riquadro Search Options, è possibile attivare la casella Only Ongoing 

Translation per limitare la ricerca ai file definiti come ongoing translation.   Ciò è 
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utile quando si aggiunge la traduzione in corso al progetto ApSIC Xbench e si 

desidera effettuare un "trova e sostituisci" completo nella traduzione in corso.    

 

 

Ricerca solo  
nei segmenti nuovi 

 

 
Nel riquadro Search Options, è possibile attivare la casella New Segments Only per 

limitare la ricerca ai soli segmenti in cui lo status è New.  Questa ricerca si rivela utile 

quando si devono effettuare “trova e sostituisci” completi solo nelle parti nuove della 

traduzione, saltando tutti i segmenti con corrispondenza del 100%.  

 

 

Escludere segmenti bloccati  
dai risultati di ricerca 

 

 
Nel riquadro Search Options, è possibile attivare la casella Exclude Locked Segments 

per escludere dalla ricerca i segmenti in cui lo status è Locked. Ciò è utile quando 

occorre concentrarsi sui segmenti caratterizzati da corrispondenze con contesti non 

esatti.  

 

 

Analisi del contesto 
 

 
Facendo clic con il tasto destro del mouse sui risultati della ricerca, e selezionando la 

voce “See context”, vengono visualizzati le dieci unità di traduzione che si trovano 

fisicamente prima e dopo quella attiva.  

 

 

Modificare il testo originale 
 

 
Il comando è disponibile in Tools->Edit Source, ed è richiamabile anche con le 

combinazioni di tasti Ctrl+Alt+Enter o Ctrl+E. Con tale coman do è possbile aprire 

il file di origine cui appartiene la voce selezionata.  Ciò si rivela molto utile per 

correggere rapidamente un errore terminologico riscontrato nella traduzione in corso.  

Se il file di partenza è un file .itd di SDLX, un file .ttx di Trados TagEditor, o una 

cartella di IBM Translation Manager, ApSIC Xbench va direttamente al segmento che 

contiene il testo.   

 

Per utilizzare questa funzionalità con IBM Translation Manager, occorre assicurarsi 

che il software sia aperto e che non ci siano documenti attualmente in fase di modifica.  

 

È anche disponibile il posizionamento di riga per i file in formato .txt e per le memorie 

esportate da Trados, ma le impostazioni dell'editor di testo devono essere configurate 

tramite il c comando Tools->Settings->Text Editor. Per esempio, per configurare 
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TextPad 4 per il posizionamento di riga, occorre selezionare il file eseguibile Text Pad 

e fornire le seguenti istruzioni nel campo Command-Line Parameters: 

$filename($line,$column).  

Altri editor di testo richiedono valori differenti in questo campo.  Si consiglia di 

consultare la documentazione dell‟editor di testo per i valori corretti.  

 

Con ApSIC Xbench è anche possibile eseguire il posizionamento di segmento per il 

formato TMX, ma nel campo Tools->Settings>TMX Editor deve essere configurato 

l‟editor di TMX. Per esempio, per configurare OKAPI Olifant per il posizionamento di 

segmenti, occorre selezionare il file eseguibile Olifant e fornire le seguenti istruzioni 

nel campo Command-Line Parameters: $Filename row=$Segment col=trg 

edit=yes. Altri editor di TMX richiedono valori differenti in questo campo.  Si 

consiglia di consultare la documentazione dell‟editor di TMX per i valori corretti.  

 

In questa maniera è possibile impiegare ApSIC Xbench come strumento utile ed 

efficiente per effettuare cambiamenti generali nella terminologia anche nei formati .txt 

e .tmx.  Se si vogliono annullare i cambiamenti effettuati, è possibile ricaricare il 

progetto ApSIC Xbench con il comando Project->Reload o View->Refresh.    

 

Modelli di Ricerca 
 
I modelli di ricerca consistono in ricerche predefinite da selezionare o da eseguire.  Per 

utilizzare un modello di ricerca, fare clic su Search Templates...nel riquadro Search 

Options e scegliere la ricerca nell‟elenco Nel campo Template Source, è possibile 

scegliere tra Sample Search Templates, Project Checklist o Personal Checklist. 

Fare clic su Search per eseguire la ricerca selezionata o fare clic su Choose per uscire 

dalla finestra dei search template e ritornare ai campi Source Term e Target Term.  
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Esportare elementi 
 

 
In ApSIC Xbench è possibile esportare elementi del progetto nei formati seguenti: 

 

 file TMX   

 file .txt 

 

 Per esportare il contenuto di un progetto selezionare il comando Tools->Export 

Items.  Viene visualizzata la seguente finestra di dialogo:  
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Si può vedere in questa finestra che è possibile esportare tutti gli elementi di un 

progetto, tutti gli elementi della query attiva, solo gli elementi visualizzati di una 

query attiva (ad esempio se si è in modalità overview, è possibile visualizzare solo 

alcuni elementi in ogni livello di priorità), oppure tutti gli elementi di un glossario 

appartenente al progetto.  

 

È possibile eliminare tutte le ripetizioni nei dati esportati (le ripetizioni sono costituite 

da elementi che hanno esattamente gli stessi valori nel campo source e target) 

riducendo le dimensioni del file prodotto.  È anche possibile escludere i segmenti 

“locked” dalla ricerca.   

 

Inoltre è possibile esportare solamente gli elementi non tradotti (ad esempio per 

agevolare l'alimentazione di un sistema di machine translation) oppure esportare 

solamente gli elementi tradotti.  Se si sceglie di esportare solamente gli elementi 

tradotti, è anche possibile specificare se esportare solo gli elementi pretradotti (ossia 

elementi ottenuti da una memoria di traduzione) o solo gli elementi ultimamente 

tradotti. 

 

Quando si esporta un file .txt, è possibile aggiungere un‟intestazione di riga.  

 

Quando si esporta un file TMX possono essere specificati i “locale” source e target.  È 

possibile inserire in tali campi qualsiasi  valore.  Se non si ricorda il codice di lingua 

“locale”, è possibile selezionare il pulsante con i puntini (…) per aprire una finestra di 

guida ed inserire la lingua ed il paese.  

 

 
 

Se di solito si lavora con un limitato numero di file, è possibile fare clic sul pulsante 

con la freccia nella casella combinata per aprire una elenco di lingue ridotto 

contenente solo le lingue recentemente usate.   
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Lavorare con le ongoing translation 
(traduzioni in corso) 

 

 
In ApSIC Xbench è anche possibile definire un file come traduzione in corso 

(“ongoing translation”) nella finestra delle Project Properties.   

 

Per impostazione predefinita una volta aggiunti al progetto di ApSIC Xbench, i 

seguenti tipi di file presentano la casella Ongoing translation attiva:  

 

 Trados TagEditor 

 File Word di Trados 

 SDLX. Attenzione: Questa opzione richiede SDLX installato nel computer. 

 STAR Transit 

 Cartelle di IBM TM 

 Déjà Vu/Idiom 

 file RTF di Logoport 

 

Quando si definisce un file o una cartella come ongoing translation, vengono attivate 

le due funzionalità seguenti:  

 

 Le traduzioni identificate come nuove (ma non corrispondenze esatte) vengono 

segnate con un puntino rosso (    )   Le traduzioni identificate come 

corrispondenze esatte (100% match) nella ongoing translation vengono segnate 

con un puntino rosso vuoto(     ). Con questi simboli è possibile distinguere un 

termine introdotto da uno già presente nella memoria di traduzione attiva. In 

questo modo è possibile effettuare scelte terminologiche, se ad esempio si ricerca 

un termine nella traduzione e si vuole essere sicuri di non averlo utilizzato 

precedentemente nella memoria di traduzione ufficiale impiegata nella 

pretraduzione del progetto.   

 

  I segmenti non tradotti vengono visualizzati dopo i segmenti tradotti.  Ciò si 

rivela particolarmente utile per decidere la terminologia da adottare per una nuova 

voce perché si possono vedere tutte le future occorrenze del termine nella 

traduzione.  In questo modo è possibile verificare se il termine scelto si adatta 

bene in tutte le occorrenze della traduzione in corso.   

 

Avvertenza: I glossari definiti come traduzione in corso ( di solito uno per ogni 

progetto, ma possono anche essere più di uno) vengono visualizzati in grassetto nella 

finestra Project Properties.  

 

Inoltre i file definiti come traduzioni in corso possono essere analizzati dalle potenti 

funzionalità di QA di ApSIC Xbench.  
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Termini chiave (Key Terms) 
 
 

Con ApSIC Xbench è possibile definire uno o più file come Termini Chiave (Key 

Terms).  A tale fine, attivare la casella di controllo Key Terms nell‟elenco dei glossari 

della finestra Project Properties. Verrà visualizzata una stella verde di fianco alla 

voce del glossario, come nella figura sottostante, ad indicare che il glossario 

appartiene alla categoria “Key Terms”.  

 

 
 

Se un file è definito come Key Term, gli elementi contenuti sono visualizzati con una 

stella e nella parte superiore dei risultati.  Il colore della stella indica che il key term è 

una corrispondenza esatta (stella verde       ), o una corrispondenza esatta tranne per i 

caratteri maiuscolo/minuscolo (stella gialla      ) , oppure se il testo ricercato è 

contenuto nell‟elemento key term (stella vuota        ).  

 



Guida all’utilizzo di ApSIC Xbench        30 

 
Il seguente esempio mostra gli elementi “clipboard” e "Clipboard Viewer" 

contrassegnati come “Key Terms”:  

 

 
 

Nel precedente esempio, la stella piena verde per l‟elemento "clipboard" indica che 

l‟elemento è una corrispondenza esatta.  La stella vuota per l‟elemento "Clipboard 

viewer"indica che il termine ricercato è parte di un key term.  

 

Anche la funzionalità di QA utilizza i Key Term di progetto verificando se sono stati 

utilizzati nella traduzione in corso.  
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Lavorare con le funzionalità di Quality 
Assurance 

 

 
ApSIC Xbench dispone di funzionalità di Quality Assurance (QA) per svolgere 

controlli avanzati sui file definiti come ongoing translation.  

Le funzioni di QA ricercano segmenti con i seguenti problemi possibili:  

 

 Segmenti non tradotti  

 Segmenti con lo stesso testo di partenza ma con testo di destinazione 

differente. 

 Segmenti con lo stesso testo di destinazione ma con testo di partenza 

differente 

 Segmenti in cui il testo di destinazione corrisponde al testo di partenza 

 Segmenti con errori nei tag 

 Segmenti con errori numerici 

 Segmenti con spazi vuoti doppi 

 Segmenti che non rispettano la terminologia chiave del progetto 

 Segmenti che corrispondono ai criteri di ricerca impostati  nel progetto o nella 

lista di controllo personalizzata. Per maggiori informazioni su questa 

funzionalità consultare il capitolo sulla gestione delle liste personalizzate 
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Le funzioni di Quality Assurance sono acessibili dalla scheda QA nella finestra 

principale. In questa scheda si possono attivare le seguenti funzioni:  

 

 Effettuare tutti i controlli selezionati nei riquadri Check Group e List of 

Checks premendo il pulsante Check Ongoing Translation.  Per 

impostazione predefinita sono attivati tutti i controlli disponibili, compreso 

Project Checklist e Personal Checklist.  

 Effettuare solo le ricerche definite in Project Checklist premendo il pulsante 

Run Project Checklist. 

 Effettuare solo le ricerche definite nella Personal Checklist premendo il 

pulsante Run Personal Checklist.  Per modificare la Personal Checklist 

attiva, selezionare il comando Tools->Manage Checklists, andare nella 

scheda Personal Checklist e fare clic su Change.   

 Esportare i risultati della funzione QA facendo clic con il tasto destro del 

mouse e selezionando Export QA Results nei formati seguenti: HTML, .txt, 

Excel,  o XML.   

 

Avvertenza: Si segnala che la licenza di ApSIC Xbench non permette la 

rimozione della scritta di riconoscimento sulla parte destra all‟inizio del report di 

QA esportato. Sono stati fatti tentativi per rendere meno visibile l‟informazione 

sulla provenienza allo scopo di evitare il passaparola o altre modalità più invadenti 

di promozione del software tra i colleghi.  

 

I risultati sono visualizzati finestra principale della scheda QA. Per la maggior 

parte dei formati, in ApSIC Xbench è possibile aprire il file direttamente nel 
segmento evidenziato e correggerlo selezionando il comando in Tools->Edit 

Source o premendo la combinazione di tasti Ctrl+E.   

 

È possibile limitare il numero delle stringhe analizzate dal processo di QA 

selezionando le caselle di controllo New Segments Only o Exclude Locked 

Segments.   

 

È inoltre possibile distinguere i caratteri maiuscolo/minuscolo nel controllo di 

coerenza selezionando la casella di controllo Case-sensitive Inconsistencies.   
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Gestire liste di controllo 
 

 
Le liste di controllo (Checklist) in ApSIC Xbench sono una funzione molto utile di 

Quality Assurance (QA). Generate dal motore di ricerca di ApSIC Xbench, le liste di 

controllo rappresentano un insieme di ricerche che possono essere eseguite in 

modalità batch per individuare segmenti con problemi.  Di solito è possibile inserire 

nelle liste di controllo errori comuni, quali ad esempio l‟utilizzo di termini o 

espressioni non ammesse.  È buona prassi inserire il feedback dei clienti nelle liste di 

controllo per accertarsi di non trascurare le segnalazioni ricevute nelle successive 

consegne di traduzioni.  

 

Nella scheda QA della finestra principale, è possibile eseguire le liste di controllo su 

tutti i file definiti come ongoing translation nel progetto di ApSIC Xbench.  

 

Poiché le liste di controllo sono generate dal motore di ricerca di ApSIC Xbench, si 

può aggiungere qualsiasi elemento che può essere oggetto di ricerca in ApSIC 

Xbench.  In realtà, un modo pratico per inserire una ricerca in una lista di controllo 

consiste nell‟effettuare prima la ricerca nella scheda Project, e successivamente fare 

clic sul collegamento Add last Search to Checklist nel riquadro Search Options 

della finestra principale.   

 

Ci sono due tipi di liste di controllo: Project Checklist e Personal Checklist.   

 

La Project Checklist viene salvata con il file del progetto ApSIC Xbench (con 

l‟estensione .xbp) e normalmente contiene i controlli specifici del progetto, come il 

controllo sull‟errata traduzione di alcune parole che non devono essere tradotte.  

 

La Personal Checklist non viene salvata nel file del progetto di ApSIC Xbench ma in 

un file di liste di controllo di ApSIC Xbench (con estensione .xbl). ApSIC Xbench 

tiene in memoria le ultime liste di controllo personali utilizzate nei vari progetti.  

Si possono salvare sul disco tutte le personal checklist che si vuole, ma è possibile 

caricarne solo una alla volta.  Le Personal Checklist di solito contengono tipi di 

controlli che non sono specifici del progetto, come errori comuni di ortografia non 

rilevati dai correttori ortografici o una particolare regola grammaticale  che è 

interessante verificare nei vari progetti.  Sono definite “personalizzate” (o 

“personali”) perché i termini compresi in questa lista di comprendono gli errori che 

ogni singolo traduttore tende a fare più spesso.   

 

Le liste di controllo sono gestite nella finestra di dialogo Checklist 

Management  accessibili con le seguenti varie modalità:  

 

 Fare clic su Add Last Search to Checklist nel riquadro Search 

Options.  Si apre la finestra di dialogo Checklist Management 

visualizzando gli ultimi dati di ricerca immessi.  È sufficiente inserire 

un nome ed eventualmente una descrizione, e quindi fare clic su Add 

Entry per aggiungere la ricerca alla lista attiva.   

 Selezionare il comando Tools->Manage Checklists.   

 Fare clic sull‟icona Manage Checklists della barra degli strumenti.  
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Nella finestra di dialogo Checklist Management è possibile aggiungere, 

modificare o cancellare tutte le ricerche desiderate alla lista attiva (Project o 

Personal).  E`inoltre possibile copiare o spostare elementi da una lista ad 

un‟altra utilizzando i pulsanti Copy to Project/Personal e Move to 

Project/Personal   
 

Inoltre, è possibile attribuire una categoria alla checklist nella casella 

combinata Category.  Si può inserire un nome di categoria qualsiasi.  Se si 

desidera utilizzare un nome di categoria precedentemente definito, è possibile 

espandere la casella combinata facendo clic sul pulsante con la freccia e 

selezionando una categoria dell'elenco che viene visualizzato. Se sono stati 

creati nomi di categoria, è possibile combinare in maniera selettiva 

sottoinsiemi di categorie in una personal o project checklist dalla scheda QA 

utilizzando i pulsanti Run Project Checklist o Run Category Checklist.  

 

 
 
La Project Checklist viene automaticamente salvata quando si salva il 

progetto.  Se si aggiungono elementi alla Project Checklist e si chiude ApSIC 

Xbench, comparirà un messaggio con la richiesta di salvare il progetto.    

 

La Personal Checklist attiva viene automaticamente salvata alla chiusura di 

ApSIC Xbench o quando viene caricata un‟altra Personal Checklist 

utilizzando il pulsante Change nella scheda Project Checklist della finestra 

di dialogo Checklist Management.  
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Informazioni aggiuntive 
 

 
Nelle sezioni successive sono fornite informazioni aggiuntive sulle funzionalità di 

ApSIC Xbench.  
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Modificare le impostazioni  
di ApSIC Xbench 

 

 
Nel menu Tools, fare clic su Settings per aprire la finestra di dialogo 

Settings, visualizzata nella seguente figura.  

 

 
 

In questa finestra di dialogo è possibile configurare ApSIC Xbench in maniera 

tale da avviarlo sempre in con il layout ingrandito (consigliato) ed anche 

modificare le combinazioni di tasti predefinite nel sistema.  Avvertenza: La 

modifica delle combinazioni veloci di tasti dovrebbe avvenire solo per evitare 

conflitti con altre applicazioni che utilizzano le stesse combinazioni veloci.  

 

I campi in questa finestra di dialogo sono:  

 

Maximize on Startup. Se attivato, ApSIC Xbench viene visualizzato 

in modalità ingrandita all‟avvio.  Si consiglia di attivare questa 

opzione poiché la modalità ingrandita è quella che fornisce la 

maggiore quantità di informazioni nello stesso tempo.   

 

Maximum Entries per Level in Overview Mode. L'overview mode 

mostra solo alcuni termini per ogni livello di priorità. Si deve specificare 

qui il numero massimo di termini per ogni livello. Se dopo la ricerca si 

desidera verificare tutte le occorrenze e conservare i vari livelli di 

priorità, è possibile premere il pulsante blu Show All Matches presente 

nella parte inferiore destra della finestra dei risultati.  

 

Le impostazioni seguenti appartengono al gruppo delle combinazioni veloci 

di tasti (Hotkeys).   
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Disable. In questa casella di controllo è possibile disattivare le 

combinazioni veloci di tasti preimpostate. Si consiglia di non attivare 

l‟opzione “Disable” poiché una delle caratteristiche più apprezzate di 

ApSIC Xbench è proprio la capacità di avviare ricerche direttamente 

da altre applicazioni.   

 

Source Hotkey. Questa combinazione di tasti ricerca il contenuto 

degli appunti nel testo di partenza. Per impostazione predefinita è 

Ctrl+Alt+Ins.  

 

Target Hotkey. Questa è la combinazione di tasti predefinita per 

avviare la ricerca “inversa”, ossia per ricercare il contenuto degli 

appunti nel testo di destinazione. Per impostazione predefinita è 

Ctrl+Alt+Backspace.  

 

Automatic Substitution Hotkey. Questa è la combinazione di tasti 

per sostituire automaticamente il testo di destinazione nell'editor di 

traduzione ed è prevista per inserire automaticamente le traduzioni. 

Per la sostituzione automatica devono verificarsi i seguenti 

presupposti:  

  

 Deve trattarsi di una corrispondenza esatta del termine ricercato.  

 Deve esistere una ed una sola variante del termine ricercato.  

 

Se una qualsiasi delle due precedenti condizioni non è soddisfatta, il 

comportamento di questa combinazione di tasti è lo stesso della 

Source Hotkey.  

 

Si consiglia di non modificare le combinazioni di tasti a meno che non entrino 

in conflitto con le impostazioni di un‟altra applicazione.   

 

Internet Hotkeys / Open in default browser. Se attivata, la query Internet 

associata alla combinazione di tasti (ad esempio Ctrl+Alt+1 o Ctrl+Alt+2) si 

apre nel browser predefinito anzichè nel browser contenuto in ApSIC Xbench. 

Per esempio, se la pagina iniziale configurata per l'apertura dei collegamenti 

Internet punta su Google, è possibile utilizzare questa funzionalità per 

ricercare il testo contrassegnato direttamente su Google semplicemente 

premendo Ctrl+Alt+1.   

 

Transfer Method.  In ApSIC Xbench sono gli appunti (blocco note) il 

sistema di trasferimento tra le varie applicazioni Windows e ApSIC Xbench. 

Di solito il metodo più comodo e affidabile consiste nel lasciare invariate le 

impostazioni predefinite Manual Copy e Manual Paste, ma in alcuni casi (ad 

esempio con applicazioni che non presentano caratteristiche standard per le 

combinazioni di tasti per il copia e incolla), potrebbe rivelarsi necessario 

modificare queste impostazioni per lavorare meglio con ApSIC Xbench. 

 

Le opzioni disponibili per il metodo di trasferimento in Input sono:  

 

Copy Message. Quando si preme la combinazione di tasti 

Ctrl+Alt+Ins, ApSIC Xbench invia una COPIA del messaggio 

all‟applicazione per copiare il testo selezionato negli appunti e quindi 

effettua una ricerca utilizzando il contenuto degli appunti. Solo un 
limitato numero di applicazioni accetta questa tecnica, ma essa 

presenta il vantaggio di evitare la copia manuale del testo negli 

appunti (di solito con la combinazione Ctrl+Ins). 
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Manual Copy. In questa modalità, ApSIC Xbench presuppone che 

l'utente abbia già copiato il testo da ricercare negli appunti. Sembra 

più complicato ma presenta il vantaggio che molte applicazioni 

adottano la combinazione di tasti Ctrl+Ins per copiare il testo, 

permettendo all‟utente di ritrovare regole simili in varie applicazioni.  

Tuttavia, se l‟applicazione di editing ha tempi di risposta lenti, si può 

ritenere troppo rapida la combinazione Ctrl+Ins, Crl+Alt+Ins  

 

Keyboard Emulation (Ctrl+Ins). In questo modalità, ApSIC 

Xbench invia la combinazione di tasti Ctrl+Ins all‟applicazione di 

editing ed in seguito effettua la ricerca.  In questa modalità l‟utente 

non deve premere Ctrl+Ins prima della ricerca. E`possibile che 

alcune applicazioni non supportino questa modalità   

 

Keyboard Emulation (Ctrl+C). In questa modalità, ApSIC Xbench 

invia la combinazione di tasti Ctrl+C all‟applicazione di editing ed in 

seguito effettua la ricerca.  In questa modalità l‟utente non deve 

premere Ctrl+C prima della ricerca. E`possibile che alcune 

applicazioni non supportino questa modalità. 

 

Le opzioni disponibili per il metodo di trasferimento in Output e Automatic 

Substitution Output sono:  

 

Paste Message. Quando si preme il tasto invio per selezionare una 

traduzione ApSIC Xbench invia un messaggio PASTE 

all‟applicazione per incollare la traduzione.  Solo un limitato numero 

di applicazioni accettano questa tecnica che presenta il vantaggio di 

evitare di incollare manualmente il testo negli appunti (di solito con la 

combinazione Shift+Ins).  

 

Manual Paste. In questa modalità, ApSIC Xbench copia il testo di 

destinazione della voce selezionata negli appunti se si preme il tasto 

Invio per selezionare una traduzione. Si prevede che l‟utente prema la 

combinazioni di tasti Shift+Ins oppure la combinazione di tasti 

corrispondente per copiare il testo nell‟applicazione).  È la modalità 

predefinita e consigliata per ragioni di coerenza tra le varie 

applicazioni.  

 

Keyboard Emulation. In questa modalità, ApSIC Xbench invia il 

testo di destinazione nell‟applicazione di editing quando viene 

selezionata una voce e preme il tasto invio per copiare la selezione 

negli appunti.   
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Fare clic sulla scheda Colors della finestra di dialogo per cambiare i colori 

predefiniti della finestra principale.  Viene visualizzata la seguente finestra:  

 

 
 

Le impostazioni di questa scheda sono le seguenti:  

 

Background color when zoomed. In ApSIC Xbench, sono 

disponibili due diverse modalità di visualizzazione: “overview”, in 

cui sono visualizzate solo alcune termini per ogni  priorità, e la 

modalità “zoomed”, in cui sono visualizzate tutte i termini di una 

priorità. In questa opzione si definisce il colore dello sfondo utilizzato 

nella modalità “zoomed”, per segnalare che non si è in modalità 

“overview” (la modalità predefinita è “overview”).  

 

Key Terms Priority. È possibile selezionare il colore che sarà 

utilizzato per i termini appartenenti alla Key Terms Priority. È 

possibile definire un glossario come glossario di Key Term in 

Project->Settings.  

 

High Priority. È possibile selezionare il colore che sarà utilizzato per 

i termini appartenenti a High Priority. 

 

Medium Priority. È possibile selezionare il colore che sarà utilizzato 

per i termini appartenenti alla medium priority.   

 

Low Priority. È possibile selezionare il colore che sarà utilizzato per 

i termini appartenenti alla low priority.   

 

Background color when nothing found. È possibile selezionare il 

colore dello sfondo che viene visualizzato nella casella di ricerca 

quando non viene trovata nessun termine.  
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Fare clic sulla scheda Internet per configurare le impostazioni Internet:  

 

 
 

Nella scheda Internet è possibile definire il percorso URL utilizzato per 

effettuare ricerche mirate su Internet, ad esempio in un dizionario.  È possibile 

impostare tutte le ricerche che si desiderano, ma solamente  per le prime 10 è 

possibile assegnare una combinazione veloce di tasti, o Alt+n se si lavora in 

ApSIC Xbench o Ctrl+Alt+n da qualsiasi applicazione Windows (in 

quest‟ultimo caso la tastiera numerica deve essere attivata) ;  n può essere un 

numero da 0 a 9, in cui 0 corrisponde alla decima voce nella lista.   

 

È possibile usare i pulsanti con le frecce per spostare la posizione di una voce 

dell'elenco verso l'alto o verso il basso.  Nel sito ApSIC sono disponibili una 

libreria di URL pronti per l‟utilizzo.   

 

Nel menu Internet sono visualizzate le prime 10 ricerche cui è stata assegnata 

una combinazione di tasti . Per aggiungere URL in quest‟elenco è possibile 

utilizzare il comando Internet->Capture URL .  
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Nella scheda Miscellaneous Settings è possibile stabilire se ApSIC Xbench 

deve verificare con frequenza settimanale l‟esistenza di aggiornamenti del 

programma. È inoltre possibile attivare la funzionalità Alternative Project.  

 

 
 

Le impostazioni in questa scheda sono le seguenti:  

 

Check weekly for new versions. Se questa casella di controllo è 

attiva, ApSIC Xbench verificherà una volta a settimana l‟esistenza di 

aggiornamenti disponibili.   

 

Enable alternative project. Se questa casella di controllo è attiva, 

ApSIC Xbench mantiene in memoria l‟ultimo progetto aperto prima 

di quello attivo.  Per passare ad un progetto all‟altro, selezionare 

Project->Switch to Alternative Project.  Per eliminare l‟alternative 

project e liberare la memoria utilizzata, selezionare Projects->Forget 

Alternative Project.  

 

Discard alternative project if not used for 1 hour. Se questa casella 

di controllo è attiva, ApSIC Xbench eliminerà l‟alternative project se 

non è stato utilizzato durante l‟ultima ora di lavoro.   

 

Load last project when ApSIC Xbench starts. Se questa casella di 

controllo è attiva, ApSIC Xbench caricherà in avvio il progetto aperto 

l'ultima volta che il programma è stato disattivato.   

 

Show warning when copying fuzzy match. Se questa casella di 

controllo è attiva, ApSIC Xbench visualizzerà un messaggio di avviso 

nel caso in cui si preme Invio per inserire una voce selezionata che 

non corrisponde esattamente al termine ricercato.    

 

Default Project Directory. In questo campo è possibile specificare la 

cartella predefinita per i progetti personali di ApSIC Xbench.  

 

Nella scheda Text Editor è possibile configurare gli argomenti delle righe di 

comando per l'editor di testo quando si utilizzano le funzionalità Edit Source 
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per la ricerca o i risultati di QA per un glossario in formato .txt.  Supporta file 

.txt, memorie esportate da Trados, memorie di Wordfast e glossari di 

Wordfast.  Se configurato correttamente, è possibile aprire il file direttamente 

in corrispondenza della riga da cui proviene il segmento selezionato con il 

comando Edit Source.   

 

 
 

Se si sceglie un editor di testo, occorre assegnare i valori ai seguenti campi:  

 

Path to Executable. Si deve indicare il percorso del file .exe dell„editor di 

testo.  È possibile utilizzare il pulsante con i puntini (...) per individuare il file 

.exe.   

 

Command-line Parameters. Con questi campi è possibile costruire la riga di 

commando che dovrebbe essere trasmessa all‟editor. È possibile utilizzare 

diverse variabili che ApSIC Xbench sostituirà con i valori. 

 

 $Filename: Il nome del file, compreso il percorso.  

 

 $Line: Il numero di riga del segmento nel file di testo. La riga indica 

il punto in cui si trova il testo di destinazione. 

 

 $Column: La colonna della riga in cui si trova il testo di 

destinazione. 

 

 $Segment: Il numero del segmento nel file di testo.  

 

Per esempio, per configurare TextPad 4 per il posizionamento di riga, occorre 

selezionare il file eseguibile Text Pad e fornire le seguenti specifiche 

nell‟apposito campo Command-Line Parameters: 

$filename($line,$column). Altri editor di testo richiedono valori differenti in 

questo campo.  Si prega di riferirsi alla documentazione dell‟editor di testo per 

tali valori.  
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Nella scheda TMX Editor è possibile configurare gli argomenti delle righe di 

comando per l'editor di TMX quando si utilizzano le funzionalità Edit Source 

per la ricerca o i risultati di QA per un glossario in formato .tmx.  Se 

configurato correttamente, è possibile aprire il file direttamente in 

corrispondenza della riga da cui proviene il segmento selezionato con il 

comando Edit Source.   

 

 
 

Se si sceglie un editor di testo, occorre assegnare i valori ai seguenti campi:  

 

Path to Executable. Si deve indicare il percorso del file .exe dell„editor di 

testo.  È possibile utilizzare il pulsante con i puntini (...) per individuare il file 

.exe.   

 

Command-line Parameters. Con questi campi è possibile costruire la riga di 

commando che dovrebbe essere trasmessa all‟editor.   È possibile utilizzare 

diverse variabili che ApSIC Xbench sostituirà con i valori:  

 

 $Filename: Il nome del file, compreso il percorso.   

 

 $Line: Il numero di riga del segmento nel file di testo. La riga indica 

il punto in cui si trova il testo di destinazione. 

 

 $Column: La colonna della riga in cui si trova il testo di 

destinazione. 

 

 $Segment: Il numero del segmento nel file di testo.  

 

Per esempio, per configurare OKAPI Olifant per il posizionamento di 

segmenti, occorre selezionare il file eseguibile Olifant e fornire le seguenti 

specifiche nell‟apposito campo Command-Line Parameters: $Filename 

row=$Segment col=trg edit=yes. Altri editor di TMX richiedono valori 

differenti in questo campo.  Si prega di consultare la documentazione 

dell‟editor di TMX per tali valori.  
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ApSIC Xbench: Suggerimenti 
 

 
Nel presente capitolo sono descritte le funzionalità più importanti di ApSIC Xbench.  

L‟obiettivo è quello di fornire una rapida panoramica sulle potenzialità di ApSIC 

Xbench.  

 

Si consiglia vivamente la lettura del capitolo per ottenere il massimo dal software con 

il minimo sforzo.    

 

 ApSIC Xbench non è un indicizzatore. Il programma legge il contenuto dei 

file ogni volta che si carica un progetto e cerca di rispondere in maniera 

veloce alle query terminologiche. Di conseguenza, il caricamento tutti i 

glossari Microsoft per una delle principali lingue può richiedere parecchi 

minuti e una significativa quantità di memoria.  Se si vuole lavorare con una 

mole notevole di materiale di riferimento, nell‟ordine di decine di milioni di 

parole, è necessario accertarsi di avere a disposizione almeno 1 GB di 

memoria. Se non si ha un computer molto potente, si consiglia di non caricare 

tutti glossari Microsoft, bensì una selezione più ristretta con le aree più 

attinenti al progetto di traduzione in corso.  
 

 Una volta caricato, ApSIC Xbench rimane attivo in background fino a 

quando non è appositamente chiuso. Quando ApSIC Xbench è attivo, viene 

visualizzato un diamante viola nella barra di sistema.  Per rimuovere ApSIC 

Xbench dalla memoria, occorre chiuderlo, ad esempio facendo clic con il 

pulsante destro del mouse sull‟icona nella barra di sistema e selezionando 

quindi il comando Shutdown Xbench.    

 

 Quando ApSIC Xbench è attivo, può essere richiamato da qualsiasi 

applicazione Windows con la combinazione di tasti Ctrl+Alt+Ins  Se 

nell„applicazione è presente testo evidenziato, ApSIC Xbench lo ricerca 

automaticamente. I tasti per l'avvio della ricerca sono modificabili.  

 

 Oltre ai glossari software di Microsofft, ApSIC Xbench può lavorare su molti 

altri formati di input e su varie applicazioni CAT tra cui Trados, SDLX, 

Transit, Wordfast; IBM TranslationManager, ed altri standard di settore quali 

TMX, TBX o XLIFF. È possibile utilizzare vari formati di file in un progetto 

Xbench  assegnando priorità ad ogni file di origine per definire il processo 

di decisione terminologica in uno specifico progetto di traduzione.  È 

possibile salvare ogni progetto ApSIC Xbench per un successivo riutilizzo.  

 

 Per copiare negli appunti il testo di destinazione della voce selezionata 

premere il tasto Invio nella finestra principale. Il tasto Invio chiude la 

finestra, copia il testo e si prepara ad incollarlo nell‟applicazione in cui è 

possibile modificare la traduzione utilizzando la combinazione di tasti 

Shift+Insert. Ciò si rivela molto utile quando si traduce la documentazione di 

un‟applicazione in cui le stringhe del software sono caricate in un progetto 

ApSIC Xbench.  

 

 È possibile effettuare controlli di QA utilizzando la scheda QA. I controlli 

QA sono eseguiti solo con riferimento a glossari definiti come ongoing 

translation (traduzione in corso). Una funzionalità molto potente di QA 

sono le liste di controllo (checklist) con cui è possibile eseguire in modalità 
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batch una serie di controlli predefiniti utilizzando le potenti capacità di ricerca 

di ApSIC Xbench.  

 

Dopo aver acquisito dimestichezza con le principali caratteristiche del prodotto, si 

consiglia di leggere attentamente la documentazione per imparare le altre numerose 

funzionalità utili disponibili.  
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Dove trovare i glossari software  
Microsoft ed Apple 

 

 

Trovare i glossari Microsoft 
 

I glossari software di Microsoft erano prima disponibili e scaricabili tramite FTP dal 

sito Microsoft, ora tuttavia sono disponibili solo a pagamento tramite sottoscrizione a 

MSDN. Ogni lingua si trova all‟interno di in un file separato .zip contenente tutti i 

glossari dei prodotti Microsoft localizzati in quella lingua. La dimensione di ogni file 

può variare da 1 ad oltre 100 Mb, secondo il numero di prodotti localizzati in quella 

lingua da Microsoft.  

 

 

Trovare i glossari Apple 
 

Attualmente i glossari di Apple Mac OS X sono disponibili al seguente indirizzo:  

 

 Tramite FTP su:  

ftp://ftp.apple.com/developer/Tool_Chest/Localization_Tools/Mac_ 

OS_X_Glossaries/  I 

 

I glossari di ogni lingua sono in formato Macintosh Disk Image (estensione .dmg).  

Per caricare i glossari Mac OS in ApSIC Xbench, occorre estrarre il file .ad contenuto 

in queste immagini di disco.  A tale fine, utilizzare il software UltraISO   

(http://www.ezbsystems.com/ultraiso/index.html). 

 

ftp://ftp.apple.com/developer/Tool_Chest/Localization_Tools/Mac_ OS_X_Glossaries/
ftp://ftp.apple.com/developer/Tool_Chest/Localization_Tools/Mac_ OS_X_Glossaries/
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Internet 
 
 

Con ApSIC Xbench è possibile definire i collegamenti Internet da utilizzare per 

ricercare i termini in Internet. ApSIC Xbench possiede un semplice browser 

incorporato, ma con la combinazione di tasti Ctrl+W, è possibile aprire il browser 

Internet predefinito del sistema nella pagina corrispondente a quella visualizzata con il 

browser ApSIC Xbench  
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Ricerche su Internet 
 

 
In ApSIC Xbench è presente una scheda Internet che fornisce un collegamento 

aggiuntivo alle fonti informative e terminologiche disponibili sul web. Nella figura 

sottostante è visualizzata una ricerca su Google eseguita all‟interno di ApSIC Xbench.  

 

 
 

 
In ApSIC Xbench sono disponibili alcuni collegamenti Internet predefiniti, ma l‟utente 

può modificarli o definire nuovi collegamenti necessari. I collegamenti predefiniti 

sono accessibili utilizzando uno dei seguenti metodi:  

 

 Spostarsi sulla scheda Internet, selezionare la fonte desiderata nel campo Web 

site, inserire la stringa di ricerca nel campo “Testo da ricercare" e premere Invio.   

 

 Quando ApSIC Xbench è aperto, premere Alt+n, in cui n può essere un numero da 

0 a 9, mentre 0 corrisponde alla decima voce nella lista.  Inserire il termine da 

ricercare nel campo Source della scheda Project o  il campo “Text to search” 

della scheda Internet. Il numero corrisponde al numero dell‟elenco dei 

collegamenti presenti in Tools->Settings->Internet.  

 

 Da un‟applicazione Windows qualsiasi, evidenziare il termine ricercato e premere 
la combinazione di tasti Ctrl+Ins seguita da Ctrl+Alt+n, in cui il numero n deve 

essere inserito con il tastierino numerico attivato.  
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Impostare i collegamenti rapidi  
con Internet 
 

I collegamenti rapidi con Internet si impostano con il comando Internet->Define 

Links.  I collegamenti rapidi sono molto facile da impostare, basta procedere come 

segue:  

 

1 Aprire la lista dei tasti di scelta rapida in Internet->Define Links. Per creare una 

nuova voce, basta spostare il cursore sotto l‟ultima voce.  

 

 
 
2 Eseguire una ricerca nella sito web che si vuole controllare. Per esempio, 

effettuare la ricerca del termine xbench su Google.  

 

3 Copiare l‟URL negli appunti, per esempio l‟URL può essere il seguente:  

http://www.google.com/search?hl=en&lr=&ie=UTF-8&q=xbench 

 

4 Incollare l‟URL in una voce della finestra e sostituire il termine ricercato con 

"%s” come nella precedente figura.  Nelle query successive che utilizzano la 

stessa stringa di ricerca, ApSIC Xbench sostituirà la sequenza %s con la stringa di 

ricerca.  

 

5 Assegnare un nome al collegamento Internet spostando il cursore nella colonna 

“Name” ed inserire il nome. Questo nome verrà visualizzato nel campo Website 

della scheda Internet ed anche nel menu a tendina Internet.   

 
6 Se nell‟elenco si desidera spostare verso basso il collegamento attivo( 

modificando così anche il numero) è possibile fare clic sui pulsanti Up e Down 

posizionati nella parte inferiore della finestra.   

 

http://www.google.com/search?hl=en&lr=&ie=UTF-8&q=xbench
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Se si nota un collegamento interessante mentre si naviga con la scheda Internet di 

ApSIC Xbench, è possibile aggiungerlo rapidamente all'elenco di pagine utilizzando il 

comando Internet->Capture URL.    

 

Se la barra degli strumenti è attiva, sono disponibili vari pulsanti della barra che 

permettono di navigare nella pagine Internet. Con un pulsante si può aprire una 

finestra di Internet Explorer con la stessa pagina che si sta guardando. È possibile 

anche usare il comando Internet ->Open Browser o con la combinazione veloce di 

tasti Ctrl+W.  
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Errori e suggerimenti 
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Segnalare errori e  
suggerimenti 

 

 
Tutti i commenti su errori del programma sono ben accolti. Prestiamo ascolto anche ai 

suggerimenti sulle modalità di miglioramento delle caratteristiche ritenute complesse.   

 

Si prega di inviare la segnalazione dell‟errore o il suggerimento a:   

http://www.apsic.com/en/products_submit_bug.aspx 

 

Tutte le informazioni inviate saranno considerate riservate e utilizzate esclusivamente 

per risolvere il problema.  

http://www.apsic.com/en/products_submit_bug.aspx

